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About CCA Program 

 

The certificate program focuses on computer fundamentals. This program provides a comprehensive 

introduction to Fundamentals of Information Technology; Computer Applications; Internet & 

Communication Technologies; Web Programming; and Soft Skills. 

The program is designed and conducted by CSC Academy along with one of the leading Management 

Institute, Institute of Management Studies, Ghaziabad (UP). Some of the core subject faculty are associated 

in delivering this program. 

After the completion of this course, student will be able to: 

• Get a basic understanding of personal computers and their operations. 
• Use of MS Office Tools - Like MS word, MS excel and Power point presentations 
• Understand basics of Programming. 
• Recognize and describe the working of Computer Networks. 
• Get familiar with the basics of communication skills 
• Develop good skills at writing business letters, emails, minutes of meeting and other business 

correspondence. 
• Design and Implement interactive, responsive web site using HTM5L, CSS5 and JavaScript. 
• Build Dynamic web site using server-side PHP Programming and Database connectivity. 

 

The CCA program covers five course modules: 

Unit 101: Fundamentals of IT & Programming 

Unit 102: Data Communications 

Unit 103: Soft Skills & Communications  

Unit 104: Web Technologies 

Unit 105: Cyber Security    
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The objective of this study material is to provide the students to enable them to obtain knowledge and 

skills in the related subject. This material is not in itself to be read alone, and student should use this in 

addition to the CCA online e-learning content study. In case students need any further clarifications or have 

any suggestions to make for further improvement of the material contained herein, they may give the 

same at CSC Academy Centre. 

All care has been taken to provide content in a manner useful to the students.   

Permission of the CSC Academy is essential for reproduction of any portion of this material. 

 

© CSC Academy 

 

All rights reserved.  No part of this book may be reproduced, stored in retrieval system, or transmitted, in 

any form, or by any means, electronic, mechanical photocopying, recording, or otherwise, without prior 

permission in writing from the publisher. 

 

Edition  :  June 2020 

 

Published by :  CSC Academy 
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About CSC Academy 

CSC Academy was setup in 2017 that provides access to professional learning for learners of diverse 

backgrounds and educational needs.   The CSC Academy is a not-for-profit society under the Societies 

Registration Act 1860 (Act 21 of 1860), as applicable to the Union of Delhi with its registered office in Delhi. 

The CSC Academy board comprises of the Additional Secretary, Ministry of Electronics & Information 

Technology, Government of India as Chairman, and others reputed members from academia.  CSC 

Academy has received certificate from Income Tax Department under section 12 AA and 80 G. 

The CSC Academy is committed to teaching, delivering of specialized courses/ training programs, 

leadership, communication skills and promotion of entrepreneurship among the rural masses in India.  

Presently, the CSC Academy is delivering various Government of India sponsored skill and education 

programs, in addition to courses from private sector.   

 

About Institute of Management Studies, Ghaziabad (UP) 

IMS Ghaziabad is a pioneer institute for management education in Northern India. It is the first institute of 

IMS Society Ghaziabad with 30 glorious years of excellence. IMS Ghaziabad offers full time AICTE approved 

& NBA accredited PGDM Programme which has been awarded the MBA equivalent status by 

the Association of Indian Universities (AIU), PGDM - International Business, PGDM - Big Data 

Analytics and MCA Programme are approved by AICTE and affiliated to Dr APJ AKTU, Lucknow. 

Since its foundation IMS Ghaziabad has gathered a lot of feathers in its cap with global accreditations and 

memberships such as Accreditation Services for International Colleges (U.K), AACSB Business Education 

Alliance, National Assessment and Accreditation Council - 'A' Grade. 

IMS Ghaziabad is amongst Top 10 best B-Schools in North India as per latest MBA and B School Rankings. It 

has been awarded as the "Best Campus for Industry Oriented Management Education in India / Asia Pacific 

2019" by ASSOCHAM and the Education Post. It has been ranked as 5th in North India and 15th in India by 

Times of India B School Survey, February 2019, A++ Institute in Delhi - NCR by 9th Chronicle B-School 

Survey 2018. 
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Course Outline 
 
 

Course Objective 

This subject aims to introduce skills relating to basic concepts and terminology of information technology & 

programming. 

 

Course Outcomes 
At the end of this course, student should be able to: 
 

1. Understand basic concepts of I.T. 

2. Have a basic understanding of personal computers and their operations. 

3. Able to use MS office tools. 

4. Understand basics of Programming. 

 

Course Details 

 

Unit I Introduction 
Introduction to computers: definitions, evolution, characteristics, Organization of a Computer, 

Classifications, Distributed Computers, Parallel Computers. 

Computer Memory: Random Access Memory (RAM), Read Only Memory (ROM), External Memory 

(Secondary Memory), Compact Disk Read Only Memory, Magnetic Storage Drives, USB. 

Software: Types of S/W - System Software: Operating System, Utility Programs Application Software, 

Overview of proprietary software, Overview of open source technology. 

 

UNIT II Introduction to MS Word 
MS Word Processing basics: Menu Bar, Using the Icons below Menu Bar; Opening and closing 

Documents: Save and Save as, Page Setup, Print Preview. 

Text Creation and manipulation: Document Creation, Editing Text, Text Selection, Cut, Copy and Paste, 

Spell check. 

Formatting the Text: Font and Size selection, Alignment of Text, Paragraph Indenting, Bullets and 

Numbering, Changing case;  

Formatting a document: Set page margin, paragraphs and sections within a document, Adjust indents 

and hanging indents;  

Table Manipulation: Draw Table, Changing cell width and height, Alignment of Text in cell Delete / 
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Insertion of row and column Border and shading, Table Formula. 

 

UNIT III Spreadsheets and Presentations 
Spread Sheet: Opening of Spread Sheet, Addressing of Cells, Printing of Spread Sheet, Saving Workbooks. 

Manipulation of Cells: Entering Text, Numbers and Dates, Creating Text, Number and Date Series, Editing 

Worksheet Data, Inserting and Deleting Rows, Column, Changing Cell Height and Width. 

Formulas and Function: Using Formulas, Function, basic mathematical operators, using AutoSum etc., 

using formulas with multiple cell references;  

Presentation - Basic Concepts of presentation: Using PowerPoint, Opening A Power Point Presentation, 

Saving A Presentation; Creation of Presentation using a Template, Creating a Blank Presentation, Entering 

and Editing Text, Inserting and Deleting Slides in a Presentation; Preparation of Slides: Inserting Word 

Table or An Excel Worksheet, Inserting Other Objects, 

 

UNIT IV Introduction to Programming 

Programming Language: Machine Language, Assembly Language, High Level Language their advantages 
& disadvantages. Basic concepts – data types and its representation in programming, basic arithmetic 
operations – addition, multiplication, division, modulus; conditional checks, relational and comparisons 
and loops 

 

Reference books 
 

1. Introduction to Information Systems,JamesO'Brien,GeorgeMarakas,TMH 
2. “Information Technology for Management”, (2010) Behl, Ramesh, 1st Ed Tata 

McGraw Hill, NewDelhi 
3. Alexis & Mathews: “Fundamentals of Information Technology”, VikasPublication. 
4. Turban - Information technology for Management : Transforming Organization in Digital 

Economy 7/e-Wiley 
5. Henry Lucas, Information Technology For Management,TMH 

 
 
 
 
 
 
 
 
 
 

http://www.tatamcgrawhill.com/cgi-bin/same_author.pl?author=James%2BO%27Brien
http://www.tatamcgrawhill.com/cgi-bin/same_author.pl?author=George%2BMarakas
http://www.tatamcgrawhill.com/cgi-bin/same_author.pl?author=Henry%2BLucas
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Unit 3 : Spreadsheets and Presentations 

  Unit 3.1: Introduction to MS Excel 

INTRODUCTION TO MS EXCEL

Microsoft Excel

Excel is one of the most widely used spreadsheet 

applications. Microsoft Excel is a software program 

produced by Microsoft that allows users to organize, 

format and calculate data with formulas using a 

spreadsheet system. This software is part of the 

Microsoft Office suite.

 

INTRODUCTION TO MS EXCEL

Starting a Excel

 Click on the Start button on the Taskbar at the 

bottom left corner of the Screen

 Highlight the All Programs item. The program menu 

will open.

 Select Microsoft Office from the list of programs. 

 Click on Microsoft Excel.
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INTRODUCTION TO MS EXCEL

When you first open Excel, the software opens to a 

new blank workbook looks as below.

 

 

INTRODUCTION TO MS EXCEL

To create a new blank workbook:

 Left-click the Microsoft Office button or File 

Tab.

 Select New. The New Workbook dialog box appears, 

and Blank Workbook is highlighted by default.

 Click on this

 A new blank workbook appears in the window.
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INTRODUCTION TO MS EXCEL

 Cell address

 Each rectangle in the worksheet is called a cell. 

Each cell has a name, or a cell address, based on 

the column and row where it is located. In below 

diagram name of selected cell  is C3 because column 

head is C and row head is 3. 

 

 

INTRODUCTION TO MS EXCEL

Live preview
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INTRODUCTION TO MS EXCEL

 To insert text:

 Left-click a cell to select it.  As you select a cell, 

the cell address appears in the Name Box.

 Enter text into the cell using your keyboard. The 

text appears in the cell and in the formula bar.

 

 

INTRODUCTION TO MS EXCEL

Live preview
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INTRODUCTION TO MS EXCEL

Live preview

 

 

INTRODUCTION TO MS EXCEL

To move through a worksheet using the 

keyboard:

 Press the Tab key to move to the right of the 

selected cell.

 Press the Shift key then the Tab key to move to 

the left of the selected cell.

 Use the Page Up and Page Down keys to navigate 

the worksheet.

 Use the arrow keys.
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INTRODUCTION TO MS EXCEL

Live Preview

 

 

INTRODUCTION TO MS EXCEL

Live preview
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INTRODUCTION TO MS EXCEL

To Save workbook using Save As command:

 Click the Microsoft Office button or File tab.

 Select Save As 

 Select the location where you want to save.

 Enter a name for the workbook.

 Click the Save button.

 

 

INTRODUCTION TO MS EXCEL

Live preview
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INTRODUCTION TO MS EXCEL

Other commands to save workbook :

First Method

 Click the Microsoft Office button or file tab.

 Select Save from the menu.

Second Method

 Click Save command on Quick access toolbar

Third Method

press Ctrl + S Key on keyboard

 

 

INTRODUCTION TO MS EXCEL

To print worksheet:

 Click on File tab,  a menu appears

 Then click on Print and 

 a Print window will pop up on the screen. 

 Finally Click on OK for your document to start 

printing.
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INTRODUCTION TO MS EXCEL

To Exit from MS Excel

 Click on ►File tab, a menu appears 

 Then click on ►Exit 

OR

 Click on the X tab in the top right corner of word 

window.
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Unit 3.2: Modifying Column, Row and Cells 

 

MODIFYING COLUMNS, ROWS, AND CELLS

To modify column width:

 Position the cursor over the column line in the column 
heading, 

 and a double arrow will appear.

 Left-click the mouse, then drag the cursor to 
the right to increase the column width or to 
the left to decrease the column width.

 Release the mouse button.

 

MODIFYING COLUMNS, ROWS, AND CELLS

Live preview
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MODIFYING COLUMNS, ROWS, AND CELLS

Another way To modify column width:

 Left-click the column heading of a column you want to  
modify. The entire column will appear highlighted.

 Click the Format command in the Cells group on 
the Home tab. A menu will appear.

 Select Column Width to enter 
a specific column measurement.

 Select AutoFit Column Width to adjust the column so 
all the text will fit.

 

 

MODIFYING COLUMNS, ROWS, AND CELLS

Live preview
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MODIFYING COLUMNS, ROWS, AND CELLS

To modify the row height:

 Position the cursor over the row line you want to 

modify, and a double arrow will appear.

 Left-click the mouse, then drag the 

cursor upward to decrease the row height 

or downward to increase the row height.

 Release the mouse button.

 

 

MODIFYING COLUMNS, ROWS, AND CELLS

Live preview
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MODIFYING COLUMNS, ROWS, AND CELLS

Other method To modify the row height:

 Click the Format command in the Cells group on 
the Home tab. A menu will appear.

 Select Row Height to enter 
a specific row measurement.

 Select AutoFit Row Height to adjust the row so all 
of the text will fit.

 

MODIFYING COLUMNS, ROWS, AND CELLS

Live preview
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MODIFYING COLUMNS, ROWS, AND CELLS

 To insert rows:

 Select the row below where you want the insert a 
new row 

 Click the Insert command in the Cells group on the 
Home tab. The row will appear.

 The new row always appears above the selected row.

 

 

MODIFYING COLUMNS, ROWS, AND CELLS

Live preview
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MODIFYING COLUMNS, ROWS, AND CELLS

 To insert column:

 Select the column to the right,  where you want to 

insert new column.

 Click the Insert command in the Cells group on the 

Home tab. The column will appear.

Note: The new column always appears to the left of the 

selected column.

 

 

MODIFYING COLUMNS, ROWS, AND CELLS

Live preview
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MODIFYING COLUMNS, ROWS, AND CELLS

To delete rows and columns:

 Select the row or column you want to delete.

 Click the Delete command in the Cells group on the 

Home tab.

 Selected column or row deleted

 

 

MODIFYING COLUMNS, ROWS, AND CELLS

Live preview
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Unit 3.3: Function & Formula 

 

FUNCTION AND FORMULAS

Function and Formulas

A function is a predefined formula that performs 

calculations using specific values in a particular order. 

 Each function has a specific order, called syntax, which 

must be followed for the function to work correctly.

 Syntax order:

 All functions begin with the = sign.

 After the = sign, define the function name (e.g., Sum).

 Then there will be an argument. An argument is the cell 

range or cell references that are enclosed by parentheses. 

If there is more than one argument, each separate by a 

comma.

 

FUNCTION AND FORMULAS

 Example of a function with one argument that adds 

a range of cells, A3 through A9:
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FUNCTION AND FORMULAS

Another example of a function with more than 

one argument that calculates the sum of two 

cell ranges:

 

 

FUNCTION AND FORMULAS

There are many different functions in Excel

Some functions are:

 SUM: Calculates the sum of range of cells together

 AVERAGE: Calculates the average of range of cells

 COUNT: Counts the number of chosen data in a 

range of cells

 MAX: Identifies the largest number in a range of 

cells

 MIN: Identifies the smallest number in a range of 

cells
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FUNCTION AND FORMULAS

To calculate the sum of a range of data using 
AutoSum:

 Select the cell where you want to appear function. In this 
example, select B8.

 Select the drop-down arrow next to 
the AutoSum command on home tab.

 Select Sum. A formula will appear in the selected cell,  
B8.

 This formula, =SUM(B4:B7), is called a function. 
The AutoSum command automatically selects the 
range of cells from B4 to B7, based on where you 
inserted the function. You can alter the cell range if 
necessary.

 Press the Enter key. The total will appear.

 

 

FUNCTION AND FORMULAS

Example - Live Preview
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FUNCTION AND FORMULAS

 To edit a function:

 Select the cell where the function is defined.

 Insert the cursor in the formula bar.

 Edit the range by deleting and changing necessary 
cell numbers.

 Click the Enter key.

 

FUNCTION AND FORMULAS

 To calculate the average of a range of data:

 Click on the first cell (in this example, b4) to be 

included in the formula.

 Left-click and drag the mouse to define a cell range 

(b4 through cell b7, in this example).

 Click the drop-down arrow next to the AutoSum 

command.

 Select Average.
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FUNCTION AND FORMULAS

Example – Live preview

 

 

FUNCTION AND FORMULAS

 Complex formulas defined

 Simple formulas have one mathematical operation.

Simple formula: =2+2

 Complex formulas involve more than one mathematical 
operation.

Complex formula: =2+2*8

 The order of mathematical operations is important. If you enter 
a formula that contains several operations, Excel knows to 
work those operations in a specific order. 

 The order of operations is

 1 Operations enclosed in parenthesis

 2 Exponential calculations (to the power of)

 3 Multiplication and division, whichever comes first

 4 Addition and subtraction, whichever comes first
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FUNCTION AND FORMULAS

 Example 1

 Using this order, let's see how the formula

20/(8-4)*8-2 is calculated 

 

 

FUNCTION AND FORMULAS

Example 2: 3+3*2=?

To calculate the correct answer:
 Calculate 3*2 first 

 Then add 3+6

 The answer is 9.
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FUNCTION AND FORMULAS

Example of how to write a formula:

 Click the cell where you want to appear the 

formula result. 

 In this example, D4.

 Enter formula =(B4+C4). Now B4, C4 are included in the 

formula.

 Important: Press Enter, or click the Enter 

button on the Formula bar. This step ends the 

formula.

 

 

FUNCTION AND FORMULAS

Example –Live preview
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FUNCTION AND FORMULAS

Absolute reference and relative reference

 Relative reference: Cell references in formula automatically 
adjust to new locations when the formula is pasted into 
different cells. This is called a relative reference.

 Sometimes when you copy and paste a formula, you don't want 
one or more cell references to change. 

 An absolute reference solves this problem.

 Absolute Reference; cell references in a 
formula always refer to the same cell or cell range . If a 
formula is copied to a different location, the absolute reference 
remains the same.

 

 

FUNCTION AND FORMULAS

Absolute reference

An absolute reference is designated in the formula by 

the addition of a dollar sign ($). It can precede the 

column reference or the row reference, or both. 

Examples of absolute referencing include:
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FUNCTION AND FORMULAS

 To create an absolute reference:

 Select the cell where you want to write the formula (in this example, H2).

 Type formula =F3*$C$2. 

 Copy the formula into H3. The new formula should read =F3*$C$2. The 

F2 reference changed to F3 because it is a relative reference, but C2 

remain constant because you created an absolute reference by inserting 

the dollar signs.

 

 

FUNCTION AND FORMULAS
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Unit 3.4.1: PowerPoint Presentation – Basic Concepts of Presentation 

 

PowerPoint Presentation

• It is an excellent way of presenting
information to an audience in visual form.

• The software is easy to use and offers a lot
of cool effects for your slideshows

• It helps both the speaker and the
participants to learn about the topic more
easily.

 

How to open graphical user 
interface of MS PowerPoint 

Software

• Click on start

• Select MS office PowerPoint option

• Double click on it
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How to open graphical user 
interface of MS PowerPoint 

Software

• Click on start

• Select MS office PowerPoint option

• Double click on it

 

 

 

 



          Certificate in Computer Applications (CCA)       

 

© CSC Academy 2020                                                                         35 
 

 

Entering and Editing Text
Adding text to a slide is very easy to do. In
fact, it's almost self-explanatory. Steps are as

follows:
Please click on the Title, Subtitle , 

or Text placeholder.

Type the text as you want.

If necessary, press [Enter] to move to a new 
line.

Click anywhere on the slide outside of the 
placeholder to deselect it.
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Unit 3.4.2: Saving a Presentation 

 

Saving a PowerPoint 
presentation

It's a good idea to keep saving our work 
periodically as we never know when we 
will lose power or when our computer is 
likely to crash.

 

Steps for saving new 
PowerPoint presentation

• Locate and select the Save command on the 
Quick Access Toolbar.

• If you're saving the file for the first time, 
the Save As pane will appear in backstage view.

• You'll then need to choose where to save the 
file and give it a file name. 

• The Save As dialog box will appear.
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Unit 3.4.3: How to Open Existing Slide 

 

To open a existing presentation in front of

audience, please follow the steps

mentioned below:

• Select the File tab to go to Backstage view.

• Select Open. Click it.

• Select Computer, and then click Browse.

Alternatively, you can choose OneDrive

to open files stored on your OneDrive.

• The Open dialog box will appear.
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Unit 3.4.4: Creating a Presentation using a Template 

 

A template defines the background, font
styles, colors and sizes for the
placeholders, as well as selected bullets
that match the template.

PowerPoint comes with a number of built
in stylish templates. It can be used
immediately.

 

To create a PowerPoint presentation using 
a template, click the File tab -> New,
and the following panel will be displayed.
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To apply a template (Steps in 

summarized form)

 Click the Microsoft PowerPoint Button,
and then click New.

 In the New Presentation dialog box, do
one of the following: Under Templates

 Click Blank and recent or
Installed Templates or Installed Themes
or click the built-in template that we
want, and then click Create.



 


